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1.0 - Introduction

On the JEOL JXA-8230 and JXA-8530F electron microprobes, the map data is
stored in a 64-bit binary format. Most image processing programs are unable to read this
file formats. This program (Fig. 1) allows the user to convert the raw JEOL binary maps
files into a format that can be easily read by other programs, and still maintain the
original image’s exact resolution.

2 JEOLMapExporter for the JEOL JXA-8x3C
File Edit Image Window About

McSwiggen &
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Figure 1. Welcome to JEOLMapExporter.
The JEOLMapExporter can convert single maps or large groups of maps into JPEG,
BMP, PNG, EPS or TXT files. The maps can be converted singularly or in a batch
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process. In addition, while the maps are open, the user can be smooth, rotate, change the
color LUT, and add or remove the scale bar.

2.0 — Selecting Files

To begin, the user selects which maps are going to be exported. Select the maps
by going to the menu item File > Select Images. The window show in Figure 2 will
open. Ifthe path is set to point at the directory containing the projects of interest, those
projects will be displayed in the first sub-window. If the path is not set correctly, click on
the Change Path button and a file manager window will open. Use this window to
navigate though the file structure until the appropriate directory is found and can be
selected.

I ’ Change Path

Projects ———— RunNo. — ID |Stg# | StagePos. - Comment —
CL-test Overnight_0001_MAP
CL_map Overnight_0003_MAP
Guidenet_map Overnight_0004_MAP
Overnight
mapping

@ Project © Stage Position @ Individual Map

o |

Figure 2. Select Images ... window.

By selecting the desired project in the first sub-window, all of the Run directories
in that project will be displayed in the second window. This will also highlight the
Project radio button until the fist window. If the Apply button were selected at this
point, all of the images in the selected project would be loaded into the
JEOLMapExporter program. If the user wants to load the maps only from a single stage
position, then the appropriate project, run, and stage number must be selected. At that
point the Stage Position radio button would be highlighted. Clicking on the Apply
button will load all the maps collected at the single stage position. The first map in the
list will be displayed (Fig. 3). The user can then step though each successive map by
clicking on the Run tab and then by clicking on the Next >> button (Fig. 4).

McSwiggen & Associates
JEOLMapExporter, v. 3.02

3 12/10/20



Figure 3.
JEOLMapExporter
displaying one of the
maps.

Figure 4.
JEOLMapExporter

displaying successive maps.

The user can step though
each loaded map by
clicking on the Run tab and
then by clicking on the
Next>> button.
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3.0 — Modifying Images

Users can perform a number of modifications to the images before they are saved.

3.1 LUT Tab

Options LUT | Smooth | Rotate | Scale |Parameters| Save Loc | Format | Gradient | Run | Console |

Auto Contrast-Brightness

Apply to all
@ Apply to all maps ©ON @ OFF

© Spectrum @ Thermal @ Grayscale

© Leave electron images as grayscale 0.000% - 100.00% =

COMPO *** GuideNet_1-1 *** Guidenet_map\Guidenet_map_0002_MAP\Pos_0002\data001.map

Figure 5. LUT Tab.

The LUT tab allows the user to perform a number of functions. First, the user can select
between three look-up tables (Spectrum, Thermal and Grayscale). The selected LUT will be applied
to the loaded images. Secondly, the user can select between having electron images stay as a
grayscale image regardless of the look-up-table selected, or whether all maps should have the same
LUT applied. Lastly the user can use an auto brightness and contrast to apply to all of their images.
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3.2 Manual Brightness and Contrast

If the user wants to manually adjust the brightness and contract, they can go to the menu item Image
>> Brightness/Contrast. This will open the window shown in Figure 6.

r

| £/ Brightness / Contrast

Figure 6. Manual Brightness and Contrast Window.

3.3 Smooth Tab

The displayed image can be smoothed by going to the Smooth tab and then by selecting the desired
window size (Fig. 7). This function only applies to the individual displayed image.

Options LT Smooth [ Rotate [ Scale ]Parameters] Save Locl Format [Gradientl Run IConsoIe \

Smooth Filter Size

f | l Smooth function applies only to the presently displayed image

COMPQO *** GuideNet_1-1 *** Guidenet_map\Guidenet_map_0002_MAP\Pos_0002\data001.map

Figure 7. Smooth Tab.
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3.4 Rotate Tab

The JEOL software stores stage-scanned maps differently from beam scanned maps. The stage-
scanned maps will be displayed rotated 90° from the original orientation. The rotate functions
allows the user to rotate the image in 90° intervals either clockwise or counterclockwise (Fig. 8).
This function only applies to the individual displayed image.

| options | LUT | Smooth | Rotate | Scale | Parameters| Save Loc | Format | Gradient | Run | Console

Image Rotation

-

CCW 90 L CW 90 Rotate function applies only to the presently displayed image

COMPO == GuideNet_1-1 = Guidenet map\Guidenet_map_0002_MAP\Pos_0002\dat2001.map

Figure 8. Rotate Tab.

3.5 Scale Tab

The user can select to either display the scale bar on the image or not. If it is to be display, the user
can select at which corner of the map to display it, and what size it should be displayed. All of these
options are selected in the Scale tab.

IOptions I LuT I Smooth I Rotate ] Scale [Parameters Save Loc | Format | Gradient | Run Console ]

® ON @ UpperLeft @ Upper Right Line Wigth PR
Display Scale Location:

@ OFF © Lower Left @ Lower Right Point Size l

COMPO ** GuideNet_1-1 *** Guidenet_map\Guidenet_map_0002_MAP\Pos_0002\data001.map

Figure 9. Scale Tab.
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3.6 Gradient Tab

The Gradient tab allows the user to correct for gradients in the backscattered electron image.
Typically these gradients result from samples that are not exactly level, thereby causing a gradient in
the intensity. Typically these gradients are not noticeable when only looking at the individual map.
However, when the maps are compiled into a mosaic map, these gradients can be distracting at best.
Figure 10 shows a comparison of an individual BSI with a modest intensity gradient, with the same
image after combining into a mosaic map.

Figure 10. Right is a backscattered electron
image with a moderate intensity gradient that
is not too noticeable when viewed
individually. However when combined into a
mosaic image (bottom), the boundaries
between the images become distinct because
of the sharp jump in intensity.
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In situations such as this, the gradient can be corrected for using the functions in the Gradient tab
before the images are exported. Figure 11 shows the same mosaic image compiled from the same
individual images, but with the intensity gradient removed before the images were compiled.

Figure 11. Mosaic image with the gradients removed from the individual images prior to combining
into a single image.

To preform a gradient correction, apply the following steps.

1) Turn the gradient correction on (Fig. 12, left side of tab frame).

2) Edit the list of maps to be worked with using the "Edit" button.

The gradient function can be used to work on an individual map or a set of maps. If working
with a set of maps the same correction will be applied to all of the maps. Therefore entire set
must be of one type (i.e. COMPO) and must have the same gradient. When the maps were
originally loaded, it is possible that maps of different types were included in the set. For
example, in Figure 13 all the maps in a particular Run are displayed. However, we are only
interested in those that are selected. The other are either calculated maps or mosaic maps
that were constructed from individual maps with the intensity gradients still present.

3) Select regions on the map using the mouse that should represent equal backscattered electron
intensity (i.e. the same phase). Use the mouse to click on a spot and then drag and release to
select a small rectangular area. After the area is selected, click on the "Set" button to record
that location. The average intensity of each area will be used to calculate the parameters for a
function that defines the gradient.
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File Edit Image Window About
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| options | LuT | smooth | Rotate | Scale |Parameters| Save Loc | Format | Gradient | Run | console |

Select Regions
Gradient © ON EdiMap List for Calibration

Correction @ OFF ‘ [+ | ruso: [ [

i t_map_0002_MAP\Pos_0002\data001.map

Select Calibration Map Order: _

Figure 12. Gradient Tab.

Comment Project | Run | Stage | Pos | Map
GuideNet 1-1 Guidenet_map\Guidenet _map 0002 MAP\Pos_0002\d
GuideNet 2-1 Guidenet _map\Guidenet _map 0002 MAP\Pos_0003\d
GuideNet_2-1 Guidenet_map\Guidenet_map_0002_MAP\Pos_0003\d
GuideNet_3-1 Guidenet map\Guidenet map 0002 MAP\Pos_0004\d
GuidelNet_3-1 Guidenet_map\Guidenet_map_0002_MAP\Pos_0004\d
GuideNet_1-2 Guidenet map\Guidenet map 0002 MAP\Pos_0005\d
GuideNet_1-2 Guidenet_map\Guidenet_map_0002_MAP\Pos_0005\d
GuideNet 2-2 Guidenet_map\Guidenet map 0002 MAP\Pos_0006\d
GuidelNet_2-2 Guidenet_map\Guidenet_map_0002_MAP\Pos_000&\d
GuideNet 3-2 Guidenet_map\Guidenet map 0002 MAP\Pos_0007\d
Single map of =i7) Guidenet_map\Guidenet_map_0002_MAP\Pos_0008\d
Single map of - 7)123456789AB Guidenet_map\Guidenet_map_0002_MAP\Pos_0009\d

JEER2 2
v s B L

Use <ctrl><command> <click> for multiple mouse selections. ID number
start | From: [N
SelectEvery [ | To: |

Figure 13. Editing list of maps to be corrected with the gradient function.
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If an undesirable location was selected, click on the "Del" button to delete it. Successive
clicks on the "Del" button will continue to remove selected area sequentially. The "Clr All"
button will remove all of the selected areas.

4) Continue to select areas across the map area that best define the intensity gradient. More than one
map can be used to select areas. Use the "Next" and "Prev" buttons to step though the map
set while selecting areas.

5) Select the order of the polynomial will be used to fit the gradient using the "Order" drop down
menu.

6) As soon as enough areas have been selected for the order of the polynomial to be use, then
"Calibrate" function will become enabled. Clicking on that button will calculate the
coefficients for the polynomial. These can be displayed in the drop down menu list just
below the "Calibrate" button. As long as there are calibration parameters displayed, and the
gradient correction function is turned on, all of the displayed maps will be corrected
accordingly. To remove the correction, click on the "Del Calib" button.

7) The "RMSD" field will display the root-mean-square deviation. This allows the user to evaluate
the goodness of fit between the different polynomial options.
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4.0 — Outputting Maps

4.1 Location Tab

Before the maps can be output, the location at which they are to be stored must be specified. This is
done in the Location tab (Fig. 14). To set the desired location, click on the Change button and select
the appropriate directory.

[Options I LuT l Smooth | Rotate l Scale ]Parameters| Save L0C| Format IGradientI Run | Console |

@ Original Location

Save Location:

ORI 1o (e 1)1 (-Te o] B C:\1 cS Assoc\EOL MapExporteriDefautthapOutput

COMPO = GuideNet 1-1 *** Guidenet_map\Guidenst map_0002_MAP\Pos_0002\data001.map

Figure 14. Location Tab.

4.2 Format Tab

There are five formats that can be used to output the images (BMP, JPEG, TIF, PNG, EPS, and
TXT). This is set in the Format tab (Fig. 15). It should be remembered that the BMP, JPEG, TIF-
RGB, PNG and EPS formats all scale the image to the range of 0 to 255. The format TIF-16bit will
record the true intensity range, as long as the values are between 0 and 65535. However, the color
information is not recorded. It will only be a greyscale image. In addition, most image processing
software (Photoshop, Imagel, etc.) will display the image with that scaling factor (0 and 65535). If
your true intensity range for that image is between 0 and, for example, 2000, then the image will be
displayed as all black until you rescale it.

[0ptions l LT ] Smooth | Rotate ] Scale lParametersI Save Loc] Format lGradientI Run |Console |

Output Format: ©® BMP @® JPEG @® TIF-RGB @ TIF-16Dbit @® PNG

riginal COMPO == GuideNet_1-1 = Guidenet map\Guidenet_msp_0002_MAP\Pos_0002\dstz001.map 45.31MB

Figure 15. Format Tab.
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4.4 Run Tab

The Run tab contains two functions. The Previous and Next buttons allow the user to step though
all of the loaded images, one image at a time (Fig. 16). The Run One button allows the user to store
one image at a time, whereas the Run All button will output all of the loaded images in one batch
process.

[ Options l LuT l Smooth I Rotate ] Scale IPammetersl Save Loc| Format | Gradient] Run Console

COMPO == GuideNet_1-1 *** Guidenet_map\Guidenet_map_0002_MAP\Pos_0002\data001.map

Figure 16. Run Tab.

4.5 Console Tab

The Console tab allows the user to track what images have been stored, their location, and their new
file name (Fig. 17). The contents of the Console window can be edited from the Edit menu, or it
can be saved as a text file by going to File >> Save Txt.

| options | LUT | Smooth | Rotate | Scale |Parameters| Save Loc | Format | Gradient | Run | Console

Input: Z:\Shared_PC_fldrJEOL-EPMA-Data\U-Pitt_Training\Guidenet_map\Guidenet_map_0002_MAP\Pos_0002\data001.map Output: C:\McSAssoc\JEOLMapExporter\DefaultMapO1
Input: Z:\Shared_PC_fldrJEOL-EPMA-Data\U-Pitt_Training\Guidenet_map\Guidenet_map_0002_MAP\Pos_0002\data001.map Output: C:\\McSAssoc\JEOLMapExporter\DefaultMapOy

< 1 | 4

riginal COMPO ** GuideNet_1-1 == Guidenet map\Guidenet_msp_0002_MAP\Pos_0002\data001.map 72.1MB

Figure 17. Console Window.
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5.0 — Installation

To installation the JEOLMapExporter program, simply click on the program, "Install-
JEOLMapExporter.jar". This will install all of the required files and will create a shortcut for the
desktop.

If a shortcut is not on the desktop, then run the program by double-clicking on the file
JEOLMapExporter_Run. Its full path should be:
C:\McSAssoc\JEOLMapExporter\NEOLMapExporter_Run.
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